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Introduction 

What is the OPC Gateway Server 
To make it as short as possible: The OPC Gateway Server is an OPC DA 
2.05 Server which forwards a subset of OPC data items from a so-called 
source OPC server to OPC clients. It acts as a gateway between the 
source server and the clients which allows to hide and/or rename OPC 
elements of the OPC namespace.  
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Who should use this manual 
This manual is intended for all users of OPC Gateway Server. It explains 
how to install and configure the software, as well as how to perform 
common tasks. 

Overview of the manual 
This manual consists of several chapters and is structured as follows: 

Introduction: This introductory chapter 

Getting started: Setting up the OPC Gateway Server in a couple of min-
utes 
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System description: A short technical description of the OPC Gateway 
Server  

User Interface: A detailed description of the user interface, including all 
dialogs and menus. 

Diagnostics: Makes familiar with the logging features of the OPC Gate-
way Server  

OPC Compliance 
The OPC Gateway Server is compliant to the OPC DA 2.05 Specification. 
It supports all required interfaces and additionally the optional IOP-
CBrowserServerAddressSpace interface. Public groups are not sup-
ported, as well as the legacy interfaces IOPCAsyncIO and IDataObject, 
as these are more a relict from the 1.0 specification and are usually not 
used in OPC DA2.05 servers and clients. 

As an additional feature the OPC Gateway server can on the server side 
make use of the IOPCItemSamplingMgt interface defined in the OPC DA 
3.0 specification if the remote server supports it. However an entire im-
plementation of the OPC DA 3.0 standard is not provided, i.e. the OPC 
Gateway Server itself does NOT provide this interface or any other OPC 
DA 3.0 functionality to the connected clients.  

Compliance is tested using the official OPC Compliance Test Tool V 2.10 
from the OPC Foundation. 

References 
To learn more about OPC visit the website of the OPC Foundation at: 
http://www.opcfoundation.org. 

The OPC Gateway Server is based on the OPC Data Access Custom In-
terface Specification Version 2.05 which is also available from the OPC 
foundation. The description of the IOPCItemSamplingMgt interface can 
be found in the OPC Data Access Custom Interface Specification Version 
3.00.   
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Getting started 

System requirements 
The OPC Gateway Server hat both Software and Hardware minimum 
system requirements. These requirements must be met in order for the 
server to work properly. 

Software requirements 
The OPC Gateway Server requires, at a minimum, the following software: 

• Micosoft Windows 2000, Microsoft Windows XP or higher 

• Internet Explorer 4.01 Service Pack 1 or better 

• OPC DA 2.0x client and server applications 

Hardware requirements 
The OPC Gateway Server requires, at a minimum, the following hard-
ware: 

• Intel Pentium II 500 MHz 

• 128 MB RAM 

• 20 MB fee hard disk space 

Installation 
Once you are certain that your system meets the system requirements, 
you are ready to install the OPC Gateway Server. 

To install the OPC Gateway Server double-click setup.exe on your OPC 
Gateway Server media and follow the instructions on the screen. 

The setup includes the OPC Core components from the OPC Founda-
tion, which are necessary for any OPC application to work properly. If 
these components are not installed on your system, the OPC Gateway 
Server will not work correctly (neither any other standard OPC applica-
tion). 

The OPC Gateway Server may be installed and executed several times 
on the same system. Every instance of the OPC Gateway Server will be 
registered as an individual OPC DA 2.05 server in the system and will 
have its own program settings. The term “instance“ refers here to each 
copy of the file “OPCGatewayServer.exe” in an individual directory. 
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First steps 
After installing and starting the OPC Gateway Server for the first time you 
will see the following screen. 

 
To start working with the gateway server an OPC Source Server needs to 
be defined and the desired subset of the source servers namespace 
needs to be configured. 

To select the server and make all necessary setting select Configure 
Server from the Edit menu or click to the corresponding link in the Wel-
come panel or on the  icon in the toolbar. The following dialog will ap-
pear: 
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Selecting the source server 
Now first an OPC source server must be selected using the dropdown list 
in the upper left side of the dialog. 

To connect to a remote OPC source server, which is not listed in the 
dropdown, you mal also enter its IP address in the edit control. If a sys-
tem with the provided address is available in the network, a list of avail-
able OPC servers will be acquired and shown.  

When a source server has been selected its namespace will be retrieved 
and filled into the tree view on the left side of the dialog. 

Setting up the public namespace 
Now all items and/or branches from the source server that should be 
available at the OPC Gateway Server can be dragged from the left tree 
view to the right tree view. The right tree view shows the namespace of 
the OPC Gateway Server as it will be available for OPC Clients connect-
ing to it. 

 
Published elements and branches can also be renamed by highlighting 
them in the right tree view and selecting the command Rename (Alias) 
from the pop-up menu that will be shown on a right mouse click. 

Setting up the server name and ID 
The OPC Gateway Server is an OPC server on its own. You may change 
the server identification by selecting the root node of the published 
namespace and changing the respective properties in the property editor 
below. 

The server name, the server ID and the vendor information can be set 
according to the personal needs. The format of server name is not stan-
dardized, so any combination of chars can be set here. The format for the 
server ID is defined in the OPC specification and should therefore have 
the format <Vendor>.<Servername> or <Ven-
dor>.<Servername>.<Version>. As the server ID is also used to build 
unique identifiers for the elements in the published name space, the ID 
must also meet some internal restrictions, i.e. it may not contain one of 
the reserved characters ‘:’, ‘\’ and ‘ ‘. 
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Setting up the update interval  

 
The update interval determines how often the data of the OPC Gateway 
Server should be updated and hence this interval will be also be used as 
the update interval for the OPC source server. The default is once per 
second (each 1000ms). To change this value, select the root node in the 
published namespace and change the respective value in the property 
editor. 
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Accepting changes 
After confirming all changes and closing the dialog the server settings will 
be changed and the new OPC server is available in the network. 

 
By selecting the Local server, Source server, Current data or Clients 
screen some status information can be displayed. If something went 
wrong the respective error messages can be found in the Event log. 

Saving the configuration 
To store the configuration for the next time the OPC Gateway Server will 
be started, select Save from the File menu. 

 
The configuration will be loaded automatically the next time when the 
OPC Gateway Server is started. To change this behavior, please refer to 
the chapter General options.  

Congratulation. The configuration is completed and the server is now 
ready to be used.  
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System description 

Introduction 
The OPC Gateway Server is an OPC DA 2.05 Server but also an OPC 
DA 2.05 Client. The purpose of the gateway server is to make an inter-
connection between external OPC clients and OPC servers, whereby the 
OPC items in the namespace provided by the OPC Gateway Server are 
either only a subset of the namespace of the external server, or the 
gateway’s namespace has a different organization with renamed ele-
ments or branches.  
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Why to use the OPC Gateway Server 
Using the OPC Gateway Server maybe especially useful, when the pos-
sibilities of controlling the access right provided by COM/DCOM as the 
underlying technique for OPC are not sufficient. COM/DCOM does not al-
low to set individual access rights for each OPC item, hence a client 
which can access an OPC server always has access to all of its items. 
This may not always be desired and this is the main situation, where the 
OPC Gateway Server comes into the play. 

 



 User’s Manual OPC Gateway Server System description  ••••  13 

Another, even though less important reason to use the OPC Gateway 
Server is when the namespace of the original server is not very well or-
ganized, and it is e.g. desired to change a flat, unorganized namespace 
into a hierarchical one. 

The technique behind 
To make the data of an OPC source server available for an OPC client 
the OPC Gateway Server must act as a server for the external client and 
as client for the external server. In fact the OPC Gateway Server is an in-
dependent server. This makes it necessary that it must have its own data 
cache to store the data provided from the source server (also called the 
remote server). Any OPC client (also called remote client) connecting 
to the OPC Gateway Server receives its data from this data cache. 
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User Interface 

The main window 
The main window of the OPC Gateway Server has a tree view on the left 
side with the title View, which allows selecting the information that should 
be displayed on the right side of the window. 

 
The first node shows the file name of the current configuration and below 
this node four sub-nodes are available: Local Server, Source server, 
Current data and Clients. By clicking to one of these sub-nodes the re-
spective status page will be shown. 

The second top-level node is called Event log and clicking this node will 
switch to the event log where all error, warning or other information is 
logged. The amount of information shown here depends on the respec-
tive settings in the environment options. Please refer to the section 
Setting the environment options to learn more about this. 
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The File Menu 
The following commands are available in the File menu: 

 

 Command  Description 

  New Clear the configuration and start with a new one. Prompts 
the user for confirmation before continuing if OPC clients 
are still connected to the server. 

  Open Load a previously saved configuration from disk. Prompts 
the user for confirmation before continuing if OPC clients 
are still connected to the server. 

  Save/Save 
as 

Save the current configuration to a file. 

Quit Shut down the server and quit the application. 

The Edit Menu 
The following commands are available in the Edit menu: 

 

 Command  Description 

  Copy Copy the selected entries of the event log to the clip-
board. Only available when the event log is displayed 
and not empty. 

  Export event log Exports the currently displayed event log to a file. Note: 
This command is intended to be used to save only the 
currently displayed events to a file. To save events 
automatically the auto-store function should be used. 
Please refer to the section Setting the environment op-
tions. 

Clear current event 
log  

Clears the currently displayed event log. This command 
has no effect to already saved event logs. 

Reset overflow 
counters 

Resets all overflow counters. Note: Overflow counters 
are used in conjunction with the local buffering of data. 

  Configure 
Server 

Opens the configure server dialog. Please refer to sec-
tion Setting up the server configuration for detailed in-
formation 

The View Menu  
The following commands are available in the View menu: 

 

 Command  Description 

Local server Show the state of the internal server  

Source server Show the state of the remote OPC server 

Current data  Show a table with all published elements and their current 
value 

Clients Show the state of the connected remote client 

Event log  Show the event log 

Refresh Forces a refresh of the currently shown information 
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The Extras menu 
The following commands are available in the Extras menu: 

 

 Command  Description 

  DCOM Configuration Start the Microsoft DCOM configuration tool to set 
up access rights for the OPC environment 

Close current event log 
file 

Close the current event log file. This option is only 
useful in conjunction with the automatic event log 
saving to hard disk to finalize the currently opened 
file and start a new one. 

  Environment options Open the environment option dialog to set startup 
options,  event logging and default values. Please 
refer to section Setting the environment options for 
detailed information. 

 

Setting up the server configuration 
The server configuration can be changed using the OPC Gateway server 
configuration dialog, which can be opened using the Configure Server 
command in the Edit menu. 

 
The configuration dialog is separated in three sections. On the upper left 
the source server and its namespace is shown. On the right you will see 
the namespace of the OPC Gateway Server, also called the public or 
published namespace. If an element of one the namespaces is selected 
and properties are available for this element, these properties will be 
shown in the lower part of the dialogue, where the property editor is lo-
cated. 
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Source server namespace 
The OPC source server can be selected using the drop-down-list in the 
upper left area. After selecting a source server, the OPC Gateway Server 
will try to start the source server and fetch its namespace to display it in 
the tree view below the list box. When the namespace is available single 
items or entire branches can be published either by using drag’n’drop, 
the  publish button  between the two tree views or by using the Pub-
lish command from the pop-up menu.  

Already published items are marked with the  icon, the publication can 
be removed by using the  unpublish button or the Unpublish com-
mand from the pop-up menu. 

Below the tree view the property editor is located. This editor shows the 
properties, like e.g. the element name of ID, of the currently selected 
element. 

Typically the namespace is shown as a hierarchical tree, but it can also 
be shown as a sorted or non-sorted list by using the  button. 

Public namespace 
The public namespace is the namespace offered by the OPC Gateway 
Server to connected clients. It can be configured by adding or deleting 
elements and branches from the source server namespace. Also addi-
tional branches can be created by using the  button or the Create new 
node command from the popup-menu. All elements and branches can be 
renamed by using the  button. 

If the items in a branch and all sub-branches should be sorted alphabeti-
cally use the button or the Sort command in the popup-menu.  

To display the public namespace as a list, the  button can be used. 
Please note, that the namespace itself will remain hierarchical, it will only 
be displayed as a list. For this reason it is not possible to make any 
changes to the public name space while it is displayed this way. This op-
tion is only included as a preview of what a client will see, when he 
browses the namespace in flat mode. If you want to create a flat name-
space use the hierarchical namespace with one single branch. 

Property Editor  
The properties of the currently selected element are shown in the lower 
section of the dialogue, in the property editor. Select an element in the 
published namespace to check or to change its properties here.  

Changing canonical data types  
As defined in the OPC specification OPC clients can request the data 
type of the data to be received from the server. If no specific data type is 
requested the data will be delivered in the default or canonical data type. 
By default the canonical data type of the published items is the same as 
of the original item on the remote server.  

To change the canonical data type of the published items, the value of 
the property data type conversion in the property editor must be set to 
respective value. The OPC Gateway Server will then request the desired 
data type from the remote server using its data type conversion possibili-
ties.  
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Note: Please be aware that the data type conversion is not for every 
combination of data types possible as not all values can be represented 
in any data type (e.g. string “Hello world” � Integer: Conversion fails) 
and possible conversion errors are not always identifiable before real 
data is tried to be converted (e.g. string “2” � Integer: Conversion ok)  

Local Data buffering  
To prevent data loss when high speed data must be transferred to slower 
clients or via networks with temporarily high load the OPC Gateway 
Server can buffer the incoming data so that it can be forwarded when the 
client is again ready to receive it. This feature is especially necessary 
when the IOPCItemSamplingMgt interface of the remote server is used 
(please refer to section using the IOPCItemSamplinghMgt interface to 
learn more about using this interface). 

When local buffering is enabled every incoming data will be stored in a 
FIFO (First In First Out) buffer and the OPC Gateway Server keeps track 
for every client which was the last transmitted data item and forwards all 
new data with the next callback.  

Note: When local data buffering is used callbacks may contain more than 
one value for the same OPC item. Some OPC DA 2.05 clients may not 
be able to process such callbacks correctly. If you notice any misbehavior 
with your client set the Forwarding strategy in to Only last value. Using 
this option may lead again to data loss as not all data can be transferred 
to the client.    

To enable and configure the local buffering select the top node of the 
published namespace and change the respective properties in the lower 
pane of the window. 
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The following properties are available to configure the local buffering: 

 

Property   Description 

Enable local buffering Enables the buffering of data within the OPC Gate-
way Server. Although this option is actually inde-
pendent of using the IOPCItemSamplingMgt inter-
face of the remote server, both options will normally 
be used together.  

Maximal buffer size Sets the maximum size of the local buffer (per item). 
Increase this value if you detect buffer overflows 
when transferring fast data to slower clients. Buffer 
overflows can be monitored using the overflow 
counters (see add statistic data).  

Forwarding strategy Determines how local buffered values should be 
transferred to the connected clients. 

Only last value 
A compatibility mode for older clients, where only the 
last value will be transferred. 

All data recently added to the buffer  
This option enables the forwarding of all buffered 
values to the client. This may lead to callbacks with 
more than one value per element. 

Note: The default settings for this options can be set in the environment 
options dialog.  

Using the IOPCItemSamplingMgt interface  
The OPC Gateway Server can on the server side make use of the IOP-
CItemSamplingMgt interface as defined in the OPC DA 3.0 specification 
if the remote server supports it to allow higher internal sample rates on 
the server side without increasing the callback rate by the same amount. 
This goal can be achieved by enabling the server side buffering (which is 
independent of the local buffering) together with a higher sample rate on 
the remote server without changing the group sample rate. While the 
callbacks will still be triggered with the lower group sample rate they will 
then contain more than one value per OPC item. To learn more about the 
IOPCItemSamplingMgt please refer to the OPC Data Access Custom In-
terface Specification Version 3.00. 
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To make use of the IOPCItemSamplingMgt interface of the remote server 
select the top node of the source server namespace and change the re-
spective properties in the lower pane of the window. 

 
The following properties are available to use the IOPCItemSamplingMgt 
interface: 

 

Property   Description 

Use the  IOPCItem-
SamplingMgt interface  

Enables or disables the data buffering on the remote 
server. Enabling data buffering allows a loss-free 
data transfer even at higher sample rates. 

Requested sampling 
rate 

Sets the interval sampling rate of the remote server. 
This settings takes effect for all elements – an indi-
vidual setting for each element is not possible.  

Remark: A requested sampling rate of “0” will lead 
to the fastest sampling rate supported by the remote 
server. 

The default settings for this options can be set in the environment options 
dialog.  

Note: An entire implementation of the OPC DA 3.0 standard is not pro-
vided, i.e. the OPC Gateway Server itself does NOT provide this interface 
or any other OPC DA 3.0 functionality to the connected clients. 
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Add statistic data  
The OPC Gateway Server provides so-called statistical data about the 
server itself and the system environment, which may be exposed in form 
of OPC elements in the published namespace. So any connected OPC 
client can retrieve this statistical data like any other OPC ele-

ment.  

Click on the arrow on the right side of the  button to add a statistical 
value as a new OPC element to the published namespace. 

The following statistical elements are available: 

 

 Statistical element  Description  

Heartbeat A continuously incrementing number which allows a 
connected client to verify that the connection to the 
OPC Gateway Server is still established. 

Time stamp of last call-
back  

Contains the time stamp of the last callback received 
from the remote OPC server (i.e. time stamp of the 
last refresh) 

Number of available 
elements 

Contains the total number of published elements. 

Number of elements 
with ‘Good’ quality 

Contains the number of published elements with 
‘good’ signal quality. 

Number of elements 
with ‘Bad’ quality  

Contains the number of published elements with 
‘bad’ signal quality. 

Number of elements 
with ’Uncertain’ quality 

Contains the number of published elements with 
‘uncertain’ signal quality. 

Number of elements 
with a specific signal 
quality  

Contains the number of published elements with a 
signal quality corresponding to a user defined quality 
mask. . You find more information regarding quality 
masks in the section ‘Setting the quality mask of sta-
tistical elements’.  

Available memory 
[Bytes] 

Contains the size of the available memory of the 
system where the OPC Gateway Server resides in 
bytes. 

Used memory [%] Contains a percentage value representing the used 
portion of the memory of the system where the OPC 
Gateway Server resides.  
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Total number of buffer 
overflows 

Contains the total number of buffer overflows when 
local buffering is enabled 

ID of the last overflowed 
element buffer 

Contains the ID of the OPC element where the last 
buffer overflow was detected. The element can only 
be used when local buffering is enabled. 

Server runtime in sec-
onds 

Contains the number of seconds since the local 
server within the OPC Gateway Server application 
has been started. On a system with a steady and not 
too high load this value should be identical to the 
value of the statistical element “Heartbeat“. 

Note: By default statistical elements whose value is calculated by count-
ing elements (e.g. depending on their quality) do ignore the statistical 
elements themselves. If the statistical elements should also be consid-
ered when counting elements please set the respective option in the 
properties of the statistic item.  

Setting the quality mask of statistical elements 

 
By using the statistical element ‘Number of elements with a specific sig-
nal quality’ the number of OPC elements whose quality bit mask corre-
spond to a user defined bit mask can be determined. To do this first of all 
a quality mask need do be defined. 

According to the OPC specification (http://www.opcfoundation.org) the 
signal quality of an OPC element contains 16 bits (= 2 Byte), whereby the 
upper byte (Bit 9 to 16) is reserved for vendor specific values and the 
lower byte (Bit 1 to 8) is used in a standardized manner. The OPC Gate-
way Server supports bit mask with up to 16 bits, but typically only the 
lower byte is used. Bit 7 and 8 contain the main quality and can contain 
the values Good, Bad and Uncertain. Bit 1 to 6 contain the sub-quality 
which may give some more specific information. 

By providing a user-defined bit mask nearly any quality value can be 
monitored. A bit mask can contain the chars 0, 1 or x representing bits, 
which must be cleared, set or may be of any value.  

As an example the following bit masks may be used to filter the main 
quality: 
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 Main quality  Mask 

Good 11xxxxxx 

Bad 00xxxxxx 

Uncertain 01xxxxxx 

So a statistical element with the provided bit mask for the ‘Bad’ quality 
would count also a quality like 00011010, because only bit 7 and 8 are 
relevant and must be 00. 

Publish array elements individually 
The OPC Gateway Server offers also the possibility to publish the ele-
ments of arrays (Datatype = VT_ARRAY) individually, which means that 
each array element will appear as individual OPC element in the pub-
lished namespace.  

 
When an OPC element of the type VT_Array is published, it will be dis-
played in the published namespace with the  symbol. By checking the 
checkbox Publish elements individually the symbol will change to  
and after accepting the configuration a new branch with the same name 
and the suffix ‘[]’ will be created. Within this branch an individual OPC 
element will be added for each array element starting with the index 0. 
The original array element will also remain in the published namespace. 

Note: You can specify if the elements of new arrays are published indi-
vidually by default on the page ‘Default values’ of the Environmental Op-
tions dialog. 
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Maximal number of elements 
Normally array elements have a fixed array length which can be deter-
mined by the OPC Gateway Server during the publishing process. But in 
some cases the length of the array data varies. In this case the maximal 
number of elements must be adjusted using the property editor. 

Note: The OPC Gateway Server creates the stated number of array ele-
ments after closing the setup dialog. If the current array has fewer ele-
ments the OPC Gateway Server will return NULL values and BAD (Out 
of service) signal quality when one of the extra elements is requested by 
a client. 

Namespace organization of published array elements  
The branch containing published array elements will be organized by the 
OPC Gateway Server as follows:  

 
After setting up the server configuration click on Accept to keep the dia-
log open or on OK to close it. 
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Setting the environment options 
By setting the environment options the overall behavior of the OPC 
Gateway Server can be adjusted to the personal needs. The settings are 
divided into three categories. 

General options 

 
The general options include the start options, which control the applica-
tion behavior regarding the server configuration at startup. Available op-
tions are to start with empty configuration, which under normal cir-
cumstances doesn’t make much sense. The default setting is re-load 
last configuration, which means that the application will try to re-load 
the last used configuration from the previous run. Maybe it is also desir-
able to define a fixed configuration file, which always will be opened with-
out regarding what was opened before. In this case use the option load 
this configuration. 

The option Enable validation controls the validation of the OPC items 
when a configuration is loaded. In general the validation makes sense to 
assure that the loaded configuration does correspond to the remote serv-
ers configuration. This allows immediate user information in case of a 
changed configuration of the remote server. 

The option Checking the system environment when selecting an 
OPC Server enables or disables the environment check. Under normal 
circumstances it is recommended to enable the environment check. 
Please refer to the section checking the system environment to learn 
more about this feature.  

By changing the language settings the language for the applications GUI 
can be set. Available languages are German and English. 

Under certain circumstances you might encounter problems with the 
transparent window style, which is used for the splash screen on applica-
tion startup and in the about dialog. If so try to change the option Splash 
and info window to fix the problems. 
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Default values 

 
By default the OPC Gateway Server will register itself on the remote 
server with its EXE-Name but this default value can be changed by enter-
ing the desired name in the edit Name used by the OPC Gateway 
Server to register with the remote server. 

Check the option Publish array elements also as single items when 
added, if the elements of a newly published array element should be 
published individually. You will find more information regarding this fea-
ture in the section Publish array elements individually. 

If additionally the IOPCItemSamplingMgt interface should be used be de-
fault if the remote server supports it check also the Use IOPItemSam-
plingMgt interface option and set the Requested sampling rate using 
the spin edit. More information about using the IOPCItemSamplingMgt in-
terface can be found in the section using the IOPCItemSamplingMgt in-
terface and in the OPC Data Access Custom Interface Specification Ver-
sion 3.00. 

Remark: A requested sampling rate of “0” will lead to the fastest sam-
pling rate supported by the remote server. 

If local data buffering should be enabled by default the option Enable 
data buffering must be checked. This will enable the spin-edit to set the 
Maximum buffer size per element and the radio buttons to define the 
forwarding strategy. Please refer to section local data buffering to learn 
more about local data buffering.  
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Event log 

 
The event log is used to log all relevant information, including errors and 
warnings, which occur during the applications lifetime. Depending on the 
situation a more or less communicative system may be desirable. This 
can be controlled by setting the logging level. Six different levels are 
available: Nothing, Very little, Little, Normal, Extended and All. The de-
fault value is normal which means that all important information is logged 
without flooding the log with irrelevant details. This setting should nor-
mally not be changed, except for diagnostic purposes. See section 
Logging to learn more about this. 

The Limit event rate checkbox is by default checked, which means that 
in case that an excessive amount of events is created by the system (e.g. 
due to a malfunction or due to a high OPC load in conjunction with the 
logging level set to All) the rate is limited by dropping events. This option 
is included to prevent the system from “hanging” due to a overload 
caused by consecutive repaint operations. This option should only be un-
checked if under certain circumstances the dropping of events is not de-
sired. This may lead to the described consequences. 

The meaning of Propagate errors and warnings to windows event log 
is quite self-explaining. This option is checked by default. 

If desired the logged events can also be stored on hard disk by checking 
the Save event log checkbox. In this case a directory for the log files 
must be selected and a maximum file and directory size must be given. 
When the maximum file size is reached the current file is closed and a 
new file is created. When the maximum directory size is reached the old-
est log file will be deleted automatically. 

Another possibility to limit the number of logged events, especially when 
the logging level is set to All is given by the option Log events from the 
following sources. By un-checking some of the listed event sources all 
events from these sources will be dropped. The list is dynamically cre-
ated, so at the first start up, the list will be empty. When the first message 
from a new source is received this sender will be added to the list. By de-
fault all senders are enabled and changing this setting should only be 
necessary for diagnostic purposes. See section Logging to learn more 
about how to use this feature. 
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Checking the system environment 

 
Every time when connecting to an OPC Server the OPC Gateway Server 
will perform a system environment check to assure a steady operation of 
the application. During this environment check some selected methods of 
the offered OPC interfaces are called to ensure their correct execution 
and the correct setting of the DCOM rights.  

Under normal circumstances the environment check should always re-
main enabled to assure the steady operation of the OPC Gateway 
Server. If for any reason the environment check should be disabled re-
move the checkmark of the respective checkbox in the general options 
section of the environment option dialog. 
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Licensing and Activation  

General 
There are three possibilities how the OPC Gateway Server can be li-
censed: 

• Demo version 
Without licensing the OPC Gateway Server is running in the 
demo mode, which offers nearly the entire functionality with 
some limitations and for a maximum run time of one hour. To 
learn more about licensing please refer to the section Licens-
ing. 

• License with product activation  
This kind of license requires explicit product activation for the 
OPC Gateway Server. The activation enables the software to 
be executed on the current system. The software will run in 
the demo mode while no activation has been done. Learn 
more about activation in the section Product activation. 

• Open license  
An open license has no restriction regarding functionality and 
is not associated to a certain system. Please take care of the 
regulations in the End User License Agreement (EULA). 

Licensing  
If the OPC Gateway Server is still not licensed this can be done immedi-
ately after starting the software. If the software is already running you 
may open the license dialog via the menu item Help | Enter license key. 

 
After clicking on License now the following dialog will appear: 
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The license key may be copied from the Windows clipboard into the re-
spective edit control or a license file (*.lic) can be imported. 

If you still do not have your valid license file, please contact us via e-mail 
at Licensing@ixts.de. 

Depending on the license file product activation may be necessary. 
Please refer to the section Product activation to learn more about this 
procedure.. 

Product activation 
Depending on the type of license you are using a product activation may 
be necessary. After activating the OPC Gateway Servers program execu-
tion in non-demo-mode will be enabled on the activated sys-

tem.  

There are three different ways to activate the OPC Gateway Server. 

The easiest and quickest way is the “auto activation” via internet. If you 
have access to the internet from the system where the OPC Gateway 
Server resides all necessary information may be exchanged automati-
cally, so the OPC Gateway Server will activate itself without further user 
interaction and the entire functionality of the system is instantly available. 

Please note that for the automatic activation a direct connection to the 
internet is necessary. The use of a proxy server is not supported. 

The product activation using our web site is the first choice if the sys-
tem where the OPC Gateway Server resides does not have a direct con-
nection to the internet. To activate the OPC Gateway Server using the 
web site a activation request file must be created on the target system 
which the will be transferred to the iXTS web site. Within a few seconds 
an activation code will be created and the activation can be completed. 
The activation service is available under http://www.ixts.de/activation.  
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Another possibility is the product activation via e-mail which may also 
be an alternative when no direct connection to the internet is available on 
the target system. To use this way the activation request file is also nec-
essary, but instead of uploading it via the website you just send it to 
licensing@ixts.de and you will receive your activation code within a short 
period of time.  

If you already have an activation code or if you received one by e-mail or 
from the web site use the option Activate with activation code to enter 
the code in the edit field. If the activation code is correct you gain full and 
unlimited access to all functions of the OPC Gateway Server. 
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Diagnostics 

Logging 
The OPC Gateway Server generates a variety of so-called events, which 
contain information about the current program state, occurred error or 
other details. These events are always logged within the application in 
the event-log and may also be automatically written to the hard disk.. If a 
problem with the gateway server occurs then the log files can be ex-
tremely valuable for troubleshooting. By default the automatic saving to 
hard disk is disabled and must be enabled when necessary. Also by de-
fault the application logs not very much information, i.e. that the logging 
level is set to normal. Both settings can be changed in the Event log tab 
of the Environment options dialog. 

 The higher the log level, the more information is recorded. However, the 
performance of the OPC Gateway Server may decrease at higher log 
levels. The recommended logging level is Normal. In most cases the Ex-
tended logging level should be sufficient to troubleshoot the problem. If 
not the All logging level will record all information available within the 
server. 

In general, the server logs all errors and other information of immediate 
importance to the user at the Little, or Very little logging level, all warn-
ings and other information of not immediate but still significant impor-
tance to the user at the Normal logging level. Information of moderate 
importance to the user will be logged at the Extended logging level, and 
further information especially for the support personnel will be recorded if 
the logging level is set to All. 

Especially in higher logging levels a lot of events may be produced so the 
server load may increase significantly. To avoid this effect, the OPC 
Gateway Server allows restricting which software classes are allowed to 
send events to the event log. To configure this feature a deeper under-
standing of the software architecture is necessary, so under normal cir-
cumstances all classes should remain enabled as event sources. 


